CSiBridge® Version 20.2.0
Release Notes
© Copyright Computers and Structures, Inc., 2018

Notice Date: 2018-09-17
This file lists all changes made to CSiBridge since the previous version. Most changes do not affect most users.
Incidents marked with an asterisk (*) in the first column of the tables below are more significant.

Changes from v20.1.0 (Released 2018-05-03)
Bridge Modeler
Enhancements Implemented
*

Incident
216246

*

219851

*

219871

220318
220321

Description
The following new features have been implemented for the user-defined Section Designer
bridge section:
(1.) Merging two layouts: in Section Designer area or solid layout view, two selected adjacent
area or solid layouts can be merged to one layout by ignoring the contact point(s) and using the
information of the free-end points to define a new layout.
(2.) "Show Selection", "Remove Selection", and "Show All" functions.
(3.) Enhancement for editing shell layout. Users can directly work on the shape/polygon of an
extruded shell layout instead of right clicking the shell layout line to input the data.
(4.) Enhancement for auto-generating the area and solid layouts.
An enhancement was implemented providing the ability to input superstructure loads within the
bridge deck-section definition to capture barrier, median, sidewalk, haunch, construction, and
wearing-surface loads.
An enhancement has been implemented to allow input of additional data on the Quick General
Bridge Template form, providing the ability to quickly define a more complete model from the
start, including substructure and superstructure geometry, loading, and design criteria.
An enhancement was implemented to allow specifying the depth of diaphragms for precast Igirder and concrete tee bridge sections. Previously the diaphragm was always full depth.
An enhancement has been implemented to allow specifying the material property for solid
bridge diaphragms used in any concrete bridge section type. Previously this capability was
limited to user-defined and Section-Designer bridge sections. By default, solid bridge
diaphragms will still use the slab material except for user-defined section designer sections.

Modeling
Enhancements Implemented
*
*

Incident
76891

222142

CSiBridge v20.2.0

Description
An enhancement has been implemented to allow a prestress tendon layout and loads to be
defined within a concrete precast I-girder frame section property. When used within a precast Igirder bridge deck section, the tendons will be automatically generated/updated along with the
bridge object.
A change has been made to default the modeling of tendons to be modeled as elements instead
of loads. Old models opened in the new version will not be changed. This change only applies
to newly generated tendons.
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Loading
Enhancements Implemented
*

Incident
218127
218188

Description
The staged-construction operations Add Guide Structure, Pour Concrete, and Remove Forms
have been added to the Construction Scheduler. These operations were already available for
staged-construction load cases. The Pour Concrete and Remove Forms operations are only
available when one or more concrete pours have been defined in any bridge object.

Analysis
Enhancements Implemented
*
*

Incident
18263

*

19076
95387

*

217067

*

221318

CSiBridge v20.2.0

Description
Rotational degrees of freedom will no longer be generated for frame (line) objects that
represent truss members. Previously these zero-stiffness rotational degrees of freedom could
generate instability warnings during analysis, even though the accuracy of the solution was not
affected unless moment loads or rotational moments of inertia were applied at these degrees of
freedom. A frame object is now automatically determined to be a truss member if (1.) End
releases are assigned for moments M2 and M3 at both ends and for torsion at either end, (2.)
The end offsets are zero at both ends, and (3.) The insertion points at both ends are at the
centroid with no joint offsets. Note that a truss member may still exhibit internal bending
moments due to transverse loading, including self-weight, but no moments will be transferred
to the structure at the two ends of the member.
Tendons will now be treated as axial-only members, such that rotational degrees of freedom
will no longer be generated for tendons modeled as elements. Previously these rotational
degrees of freedom could generate instability warnings during analysis for straight tendons,
even though the accuracy of the solution was not affected. This change also means that the
small amount of torsion and bending moment that previously could be carried by a tendon will
no longer be considered. This may result in a small change in analysis results compared to
previous versions of the software when running the same model. This effect will generally be
negligible. Tendons modeled as loads are not affected by this change. The calculated results for
Verification Examples 1-009, 2-020, and 5-009 have changed due to this enhancement, and the
published results have been updated for the new values. The difference was less than 0.03% for
all three examples.
The speed of the analysis has been increased for nonlinear static and direct-integration timehistory load cases where a very large number of load patterns is applied. However, it is still
more efficient to use the minimum number of unique load patterns required for any given
purpose, rather than using duplicated load patterns.
An enhancement has been implemented to allow objects to be removed during a nonlinear
direct integration time history analysis for the purpose of simulating dynamic collapse. One or
more objects can be removed from the structure at specified times during the load case. When
an object is removed, it is replaced with equivalent forces that are then ramped down to zero
over a specified duration. This feature can be used, among other purposes, to check that
structures remain stable after removal of individual columns.
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Bridge Design
Enhancements Implemented
*
*

Incident
79610
215523

*

216176

*

218227

Description
Additional bridge load rating checks have been added according to the Canadian CAN/CSAS6-14 code. The new checks consider shear strength for composite steel I-girder bridge
sections, and both flexural and shear strength checks for steel U-girder bridge sections. The
flexural strength check for composite steel I-girder bridge sections was already available in the
previous version. Live-load distribution factors can be specified by the user or determined from
detailed 3-D live-load analysis. Rating results are displayed graphically for the entire box
section or on a girder-by-girder basis for box girders and composite sections. Detailed tables
showing all results and intermediate values are available for display, printing, and export to
Excel or Access.
Bridge load rating has been added for steel U-girder composite bridge superstructures
according to the AASHTO "Manual for Bridge Evaluation", Second Edition, 2010, including
the interim revisions to 2015. Separate rating requests are provided for the service and strength
checks of composite superstructures. Live-load distribution factors can be automatically
calculated using code formulae, specified by the user, or determined from a detailed 3-D liveload analysis. Rating results are displayed graphically on a girder-by-girder basis. Detailed
tables showing all results and intermediate values are available for display, printing, and export
to Excel and Access.
All bridge superstructure design and rating requests that support the AASHTO code 7th Edition
(2014) have been updated to the 8th Edition (2017). Both editions of the code are available as
an option.

Results Display and Output
Enhancements Implemented
*

Incident
216109

216665

218282

Description
A change has been made to the labeling of staged-construction load cases and stages generated
from the Construction Scheduler. Previously, the text defined in the Output Label column was
used for two purposes: (1) As the Output Label for the stage defined by the row in the
Scheduler containing the text, and (2) As a suffix in the name of the subsequent load case
created when the checkbox End Case was checked in the Scheduler. In some cases this could be
misleading, particularly when the label was corresponding to a group header in the Scheduler.
Now, load cases will always be labeled with an incremental integer suffix starting from "-1"
and the Output Label string will be utilized only for stage definition. Note that labels on group
headers are not recommended. They apply only to the operations defined as part of the group
header itself, and not to stages defined as part of the group. The label should be applied to the
last operation in the group rather than to the group header itself.
An enhancement was implemented for the table Bridge Object Girder Forces in which the field
"Distance" was changed to "Station", and two new fields "Span" and "GirderDist" were added
to the table to identify the location of each bridge section cut where results are provided.
"GirderDist" is the distance measured along the centerline of the girder from the start of the
"Span" containing the section cut.
An option has been added to the command Home > Set Display Options to control whether or
not to show the Guide Structure when displaying analysis and design results. This only affects
the display for load cases that are based on staged construction where the command Add Guide
Structure has been used. This option affects each model window separately.

Installation and Licensing
Enhancements Implemented
*
*

Incident
216251

CSiBridge v20.2.0

Description
The version number has been changed to v20.2.0 for a new intermediate release.
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Bridge Modeler
Incidents Resolved
*

Incident
215731

216068

218109

*

219274

219638

*

219932

CSiBridge v20.2.0

Description
An incident was resolved for the Bridge Modeler in which the "Copy Tendon to All Girders"
feature did not work if a parametric variation was assigned to a bridge span and the difference
between the span length and the length of the parametric variation was between 2.5 and 10
times the Auto Merge Tolerance. The Auto Merge Tolerance is set using the command File >
Settings > Tolerances, and defaults to 0.1 inch or 1mm. When this error occurred, an error
message was produced, the tendon was not copied, and the original tendon was retained.
An incident was resolved for the Bridge Modeler where a bridge object with bridge section of
type Advanced Concrete Box Girder could not create or update its linked structural model
when (1) the bridge object had not been created initially using the template from the command
New > Quick Bridge, and (2) the bridge section option “Constant Girder and Fillet
Dimensions?” was set to “No”. When this occurred, no results were available for the affected
bridge object.
An incident was resolved for the Bridge Modeler where the girder length within certain spans
may not have been calculated correctly for a bridge object when the bridge section parametric
variation assignment of the span was defined as "Reference to Another Span". This could
affect, for example, the longitudinal location of section transitions (plate-size changes) in the
model. This issue was rare and could be corrected by opening the Bridge Section Variation
Definition form for the affected span and clicking OK (command Bridge > Spans >
Modify/Show Section Variation Along Selected Span). Models will be automatically corrected
when they are opened in the new version.
An incident was resolved for the Bridge Modeler where the girder span length used when
assigning transverse reinforcement to a bridge girder was incorrect for interior girders that were
not present in one or more of the previous spans for that bridge object. For example, if the first
two spans had two interior girders and the third span had three interior girders, the girder span
lengths used when assigning transverse reinforcement for the third interior girder in the third
and subsequent spans would actually be the lengths of the first and subsequent spans,
respectively. If the girder span length used was shorter than expected, this could prevent
assigning transverse reinforcement for the entire length of the desired span. If the girder span
length used was longer than expected, this would result in an error message if transverse
reinforcement was assigned beyond the actual end of the span. Design results were consistent
with the actual reinforcement assigned. Analysis results were not affected.
An incident was resolved for the Bridge Modeler and the Bridge Scheduler where updating a
linked bridge model would sometimes generate an error message if a construction schedule had
been defined that referenced groups that were specified as part of the bridge object being
updated. When this error message was displayed, the groups referenced in the stagedconstruction load case(s) generated by the Scheduler would not be correct and the analysis
results produced for the affected load case(s) might not be as expected. Analysis results were
consistent with the load case, but the load case was not consistent with the construction
schedule. The text of the error message displayed when updating the linked bridge model was
"Error writing schedule back to CSiBridge via API".
An incident was resolved for segmental bridge models in which the program could terminate
when using the View/Rename Segments command after deleting a duct template.
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Loading
Incidents Resolved
*
*

Incident
213033

*

218198
219840

*

220179

Description
An incident was resolved where bridge temperature-gradient loads were not correctly
calculated for bridge objects having a user-defined (Section Designer) bridge section if the
vertical Y coordinate (in Section Designer) of the bottom-most point of the bridge section was
not zero. Affected models should be re-run in the new version to determine the effect of this
error. Only temperature-gradient loads applied to user-defined bridge sections were affected.
User-defined sections have been available starting with version 18.0.0.
An incident was resolved where the operation Remove Forms in staged-construction load cases
added concrete material at age zero, which caused excessive deflection when time-dependent
analysis was performed. Staged-construction load cases that did not consider time-dependent
material behavior and/or concrete materials that did not consider time-dependent behavior were
not affected. The Remove Forms operation only applies to Concrete Pours (Slab Wet Concrete
Loads), which can be defined for the top slab of bridge objects. Now the Remove Forms
operation requires specification of the age of the concrete when the forms are removed, which
must be greater than zero. Models from previous versions will have this age set to 3 days, but
this can be modified after opening the model in the new version. Additionally, the default age
has been set to 3 days for all staged-construction operations that use age; previously the default
value was 0 or 1 day.
An incident was resolved where the response to influence-based moving-load cases could be
incorrect when floating lanes were used. The transverse position of the lanes could be
calculated incorrectly for the case where there was a transverse gap between two sets of lanes
within a floating lane set. In some cases, this could lead to a smaller value of the response than
should have been calculated for the lanes with a gap. The case where all floating lanes within a
floating lane set were contiguous was correct, and usually governed the response. Even for
responses where the contiguous set of lanes did not govern the response, it still provided a
lower bound for the response, so that the error was generally small. The affected cases were
primarily restricted to localized response where lanes divided between the two outer edges of
the superstructure governed. This rarely had a significant effect on the superstructure response
of girders, slabs, and composite response used for bridge superstructure design and rating. On
the other hand, transverse members, such as bent caps, were more likely to be affected.

Section Designer
Incidents Resolved
*
*

Incident
217402

CSiBridge v20.2.0

Description
An incident was resolved for Section Designer in which the angle specified between the
Section Designer X axis and the frame-section local 2-axis, as well as the maximum mesh sizes
specified to determine the mesh used to calculate the torsional and plastic section properties,
are now all saved in the model file (.BDB) and in database table "Section Designer Properties
01 - General". These parameters may be different for each Section Designer section. Previously
the angle was saved in the model file, but not in the database table, so it would be lost upon
import from text file. The maximum mesh sizes were not being saved at all, and were reset to
default values each time the model was opened or the section was opened in Section Designer.
In addition, the specification of the maximum mesh sizes in Section Designer has now been
moved from the Options > Preferences form to the Display > Section Properties form, where
the angle was already being specified.
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Analysis
Incidents Resolved
*

Incident
215596

*

215894
217830

216323

*

*

214417
219777
221011
216608

*

217190

*

222053

CSiBridge v20.2.0

Description
An incident was resolved where a material property, hinge property, or nonlinear-plasticity link
property using the Pivot-type hysteresis model and having a backbone curve with compressiononly or tension-only behavior (i.e., zero force and stiffness in one direction) would produce
undefined analysis results after yielding occurred. These analysis results would be reported as
"NaN" (not a number) instead of as numerical values. Graphical displays of such analysis
results would be blank. This behavior could affect all response quantities reported for the
model, not just for those objects using the nonlinear material, hinge, or link property itself.
Only nonlinear load cases and linear load cases using the stiffness at the end of a nonlinear load
case could be affected. Nonlinear material properties only affect fiber hinges and layered shells.
This error was not common since the Pivot model is not really applicable to tension-only or
compression-only behavior.
An incident was resolved where the direct strain reported for a layered shell with nonlinear
directional material was incorrect for nonlinear static and nonlinear direct-integration timehistory load cases. This typically affected strains E11, E22, Emax, Emin, and Evm, and the
reported values were half of the expected value. The only layers affected those where the
material was specified as Directional and one or more of the components S11, S22, and S12
were set to Nonlinear. Layers where the material was specified as Coupled, or where all three
components were set to Linear, were not affected. Linear load cases were not affected, nor were
nonlinear modal (FNA) time-history load cases.
An incident was resolved where a material property defined with nonlinear hysteresis type
"Isotropic" was being treated as a "Pivot" hysteresis model with the following properties:
Alpha1 = 100, Alpha2 = 100, Beta1 = 1, Beta2 = 1, and Eta = 0. This would only affect
nonlinear static and direct-integration time-history load cases for models where such a material
was used in fiber hinges (frame or wall) and/or in layered shells. The energy dissipation would
be less than expected for an "Isotropic" hysteresis model, and would be similar to that for the
"Takeda" hysteresis model.
An incident was resolved where a “Remove Forms” operation (usually following a “Pour
Concrete” operation) on a staged construction case properly added the slab objects with their
full stiffness but ignored their weight.
An incident was resolved where the transverse shear stiffness was too flexible by a factor of
two for layered shell elements with nonlinear properties (both Directional and Coupled types).
Layers where the components S11, S22 and S12 were all specified as Linear and/or Inactive
were not affected. For a shell element with multiple layers, only those layers with one or more
components specified as Nonlinear contributed to the excess flexibility. For most models,
where flexural flexibility dominates, the effect of this error was negligible.
An incident was resolved where element loads on a shell element and specified to act in a fixed
coordinate direction (such as gravity) would be incorrect after a change modifier command
from a nonlinear staged construction load case was used to change the weight modifier of the
element. This issue was not present if the weight modifier was not changed in the current or
prior load cases. This issue only affected nonlinear static and nonlinear direct-integration time
history load cases with the "Geometric Nonlinear Parameters" set to "P-Delta plus Large
Displacements".
An incident was resolved where mass-proportional damping specified in the material property
definitions was not being considered for shell elements in nonlinear direct-integration timehistory load cases. Additionally, this issue sometimes required extra iteration to reach
convergence. Mass-proportional damping specified in the load case itself was not affected.
Models without shell elements or without mass-proportional damping in materials used by shell
elements were not affected.
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Bridge Design
Incidents Resolved
*
*

Incident
212584
220221

*

215296

215905

*

217496

*

217820

218537

218681

CSiBridge v20.2.0

Description
An incident was resolved where the Ritz modes calculated for "Load Inertia" loading could be
incorrect. These special type of Ritz modes are used only for bridge seismic design requests of
type "Caltrans Fault Crossing", and they do not affect other types of analysis or design. The
effect of this error on Caltrans Fault Crossing seismic design was often insignificant, but could
cause incorrect calculation of the dynamic (response-spectrum) portion of the demand. The
nonlinear-static portion of the demand was correct, as was the capacity. Bridge seismic design
requests of type "Caltrans Fault Crossing" should be rerun with the new version.
An incident was resolved for steel U-girder superstructure design according to the Canadian
CAN/CSA S6-06 and S6-14 codes where the yield moment was not calculated correctly
causing an invalid assessment that the section yielded under Mdc+Mdnc demands. This
affected the Steel U Composite Strength and Constructability (Staged and NonStaged) design
requests.
An incident was resolved for bridge superstructure design of steel U-girder bridges per the
AASHTO LRFD code where the LambdaF factor was calculated using the entire width of the
bottom flange. Now only the width of the flange between the webs is used per AASHTO
6.11.8.2.2-8. The previous version resulted in slightly conservative values of LambdaF.
Impacted design checks are: Steel U Comp - Strength, Service and Constructability for the
AASHTO LRFD code, all versions.
An incident was resolved where the stresses calculated for a steel I-girder bridge could be
incorrect at a bridge-object section cut in the following case. If the steel I-girder was nonprismatic with a stepped section transition, and the section cut was near but not right at the
stepped transition, then the stresses computed in the steel I-girder could be incorrect either
before or after the section cut. In such a case the forces and moments acting at the section cut
were correct, but the stresses were computed assuming the section properties on the other side
of the transition. This affected the stress output shown in the Bridge Response Display form,
reported in the database tables, and used for bridge superstructure design. Design checks that
use forces and moments rather than stresses were not affected. This error was not common,
particularly when girder-local sections cuts were used, since these are generated right at the
section transitions. Stresses in the slab were not affected.
An incident was resolved for bridge superstructure rating of steel I-girder bridge sections using
the AASHTO code where the rating request was terminated with the error message "Error
locating non-prismatic section at section cut index". This error could occur when some sections
were classified as invalid for code-based live-load distribution factors (LLDF). When this
occurred, no results were available for the affected rating requests. This error did not occur
when the live-load distribution for the design request was calculated directly from analysis or
with user-specified LLDF. Impacted rating requests: Steel I Strength and Steel I Service for the
AASHTO LRFD code, all versions.
An incident was resolved for bridge superstructure rating where the command Design/Rating >
Load Rating > Optimize Bridge generated an error message and and was unable to perform
rating optimization for steel I-girder and U-girder bridge sections. No other results were
affected. Optimization for superstructure design was not affected.
An incident was resolved for the bridge superstructure design, rating, and optimization of steel
I-girder and U-girder bridge sections where the presence of an all-space (full-width) diaphragm
could be ignored from consideration by the design/rating request if the longitudinal distance
between the diaphragm location and the nearest bridge section-cut location was small, in
particular, between the merge tolerance and ten times merge tolerance. The merge tolerance is
defined using command File > Settings > Tolerances, and is typically on the order of 0.1 inch
or 1 mm. This error was not common. All design and rating requests for steel I-girder and Ugirder bridge sections were affected for all codes. Analysis results were not affected.

ISO# RELBRG2020

2018-09-17

Page 7 of 9

*
*

Incident
219373

*

220335

Description
An incident was resolved for bridge superstructure design of steel I-girder and U-girder bridge
sections per the Eurocode where the SigmaS value was sometimes not calculated correctly
based on values from Eurocode 1994-2 Table 7.1 (bar diameter dependent). Due to a rounding
error, in certain cases the SigmaS was read as if belonging to a higher bar diameter than
specified, resulting in a lower value of SigmaS. This could be unconservative. This error
affected the Steel I Comp Min Rebar and the Steel U Comp Min Rebar design checks.
An incident was resolved for bridge superstructure design and rating where the code-based live
load distribution factors (LLDF) for steel U-girder bridges with precast slab sections were
incorrectly calculated using the AASHTO LRFD formulas for Concrete Deck on Concrete
Spread Box Beams. The formulas have been corrected to now use the AASHTO LRFD
formulas for Concrete Deck on Multiple Steel Box Girders. The impacted design and rating
requests include Steel U Strength, Steel U Service, and Steel U Web Fatigue for all versions of
AASHTO LRFD. Design and rating requests using forces directly from analysis or user-defined
LLDF were not affected.

Results Display and Output
Incidents Resolved
*

Incident
215221

215670

*

218106
218678

221143

CSiBridge v20.2.0

Description
An incident was resolved where the AASHTO LRFD Steel I Comp Fatigue complete
calculation report was not showing the correct calculation of live load distribution factors. The
complete report failed to take into account the fact that for fatigue loads only one lane is loaded
and a compensation needs to be made for multiple lane presence factors. The demands and
DoverC calculations were utilizing the correct LLDF factor, only the part of the report where
the LLDF is evaluated was incorrect.
An incident was resolved where certain individual girder analysis and design results could not
be displayed on the Bridge Object Response Display form when a bridge object contained two
or more spans and the number of girders in one span was larger than the number of girders in
the subsequent span. This error affected versions 19.0.0 to 20.1.0. No results were affected.
This form is accessed using commands Home > Show Bridge Superstructure Forces/Stresses
and Home > Show Bridge Superstructure Design Results.
An incident was resolved in which the program would terminate for certain models when
attempting to export data to Excel from the Bridge Object Response Display form.
An incident was resolved for bridge superstructure design of steel I-girder bridges per the
AASHTO code where the AASHTO equation 6.10.9.3.2-6, used for determining the C value,
was presented incorrectly in the detailed design report. The (E*k/Fyw) term was incorrectly
displayed within a square root. The actual value was correctly calculated (no square root was
used) for the design calculation, and no results were affected. The error was only in the report
presentation. The impacted calculation reports were for design requests: Steel I Strength, Steel I
Constructibility, Steel I Fatigue, and Rating Steel I Strength for all versions of AASHTO
LRFD.
An incident was resolved where the Bridge Object Response Display form would not show
results for certain girders in one bridge object if there was another bridge object in the same
model that had fewer girders, and if the bridge object with more girders had been updated after
the bridge object with fewer girders. The number of girders that could be displayed in both
bridge objects was limited to the smaller number. The affected commands were Home >
Display > Show Bridge Superstructure Forces/Stresses, Show Bridge Superstructure Design
Results. This was a display issue only. Results presented in tables and used for superstructure
design and rating were not affected.
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User Interface
Incidents Resolved
*
*

Incident
216471
217193
217285
219575
219929
219943
217425

CSiBridge v20.2.0

Description
An incident was resolved in which the program would terminate when attempting to display the
Define Bridge Deck Sections form from the ribbon, the menu, or the bridge wizard. This was a
user interface issue only and did not affect results.

An incident was resolved in which the splice definition name was unable to be modified from
the default using the Bridge Splice Property form. It was possible to modify the name via the
interactive database. This was a user interface issue only and did not affect results.

ISO# RELBRG2020

2018-09-17

Page 9 of 9

